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2 Introduction

Introduction
Thousands of dental practices use Dentrix to run their dental practice. Dentrix boosts 
staff productivity, enhances professionalism, helps keep chairs full, increases collections, 
and improves the bottom line. And, with its extensive suite of eServices products 
and third-party partnerships, Dentrix provides many profitable integration solutions.

This Installation Guide will help you install and register your Dentrix G6 software.

Before Installing Dentrix

Before installing and using Dentrix, you should be familiar with using the computer. 
The Dentrix documentation is written with the assumption that you are familiar with 
using a PC and Microsoft Windows.

Microsoft Windows must be installed before you can install Dentrix. For information on 
supported Windows versions, read the Dentrix G6 System Requirements included in 
the box with your software and available online at www.Dentrix.com. For information 
about installing and using Windows, refer to the Windows documentation.

How To Get Help

Henry Schein recommends that dental offices contact Henry Schein TechCentral 
(1.877.483.0382) or another qualified integration specialist for new installation or 
upgrade assistance.

You can find answers to many questions about Dentrix in the Dentrix Help, which 
you can access from the Help menu of each Dentrix module. A secondary resource 
is the Dentrix G6 User’s Guide (available on the Windows desktop after installing 
Dentrix and in the Dentrix Resource Center at www.Dentrix.com/resource-center). 
You can find additional information, including on-demand tutorials, at 
www.Dentrix.com/resource-center.

If you are on a current Dentrix Customer Service Plan, you can access the Dentrix 
technical support knowledgebase at www.Dentrix.com/resource-center for answers 
to common questions.

If these methods do not provide an answer, contact Dentrix Customer Support at 
1.800.DENTRIX. Toll-free telephone support is available only to registered Dentrix 
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users on a current Dentrix Customer Service Plan. Registered users not on a current 
support plan will be charged for telephone support. (For current pricing information, 
visit www.Dentrix.com/support/contact-us.aspx) 

Support is limited to the current version of the software and one prior release. When 
calling customer support, be near a computer running the Dentrix software. Be 
prepared to give the following information:

• Your name and the name of the practice

• The Dentrix customer number assigned to the practice

• The version number of the product being used

• The type of network being used, if any

• The version of Windows installed on the computer

• The exact wording of any messages that have appeared on the screen

• The circumstances surrounding the question or problem

• Steps that have been taken to reach a solution 

Installing Dentrix G6 From a DVD

In an effort to provide you with current technology solutions, the Dentrix G6 
installation program is on one DVD. Most modern computers have DVD readers 
installed. If your computers meet the Dentrix G6 system requirements, installing 
Dentrix G6 from DVD will not be a problem for your office. If you have any questions 
about installing from DVD or want to make sure your hardware is ready for Dentrix 
DVD installation, please contact your hardware technician or call Dentrix Customer 
Support at 1.800.DENTRIX.
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New Features
Some of the new features available in Dentrix G6 are briefly described in this 
section. For additional information about these features and other changes in 
Dentrix G6, refer to “What’s new in Dentrix G6?” in the Dentrix Help, and the Dentrix 
G6 Release Guide in the Documentation folder of the Dentrix G6 DVD and in the 
Dentrix Resource Center.

Alerts

• Medical alerts were enhanced so you can save medical alert notes in the notes 
history. You can copy medical alert notes to clinical notes, include medical alert 
notes in the Patient Notes Report, and add patient notes from Questionnaire 
forms to the medical alert note. 

• In the Create Patient Alert dialog box, a new “Questionnaires” option was added 
to the list of options where a patient alert could be displayed in Dentrix. 

Appointment Book

• When you create an appointment, you can now type a specific appointment length. 

• You can now specify an additional Provider ID for an appointment. You can also 
display this additional Provider ID field in the appointment block, Hover window, 
the Print Appointment Book View Report, the Patient Route Slip, and the Patient 
Visit Form.

• The Set Appointment Procedures Complete dialog box in the Appointment 
Book now allows you to view and easily assign providers to procedures before 
posting them. 

• Appointment blocks, the Hover window, the Appointment Information dialog 
box, and the Appointment History dialog box now include a Date/Time Created 
field and Staff ID field so you can see when the appointment was created and 
who created it. 
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Document Center

• The Document Center now provides a method to support documents scanned 
from all scanners as long as they use a supported Document Center format: .pdf, 
.doc, .docx, .xls, .ppt, .bmp, .gif, .jpg, .png, .txt, and .rtf. Other changes were made 
to make scanning documents easier. 

Ledger

• Several enhancements were made to the Ledger including new columns (entry 
date, surfaces, check #), adjustable column widths that are automatically saved 
when you close the Ledger, the ability to sort by and hide columns, a note 
indicator for payments and adjustments that have a note, tooltips for the column 
headings, alternate row shading, and a Refresh button on the toolbar. 

• When clicking Enter Batch Payments from the File menu, a new Batch Payment 
Entry dialog box appears with enhanced functionality.

• You can now split payments by multiple family members.

• In the Ledger Colors Setup dialog box, a new Restore Defaults button was 
added so you can restore the default Ledger colors. 

Letters/List Manager

• You can use a new List Manager tool (similar to the one in Collections Manager 
and Treatment Manager) to create, view, and print customized lists of patient 
information. The List Manager also allows you to “hide” patients and merge 
letters for only the listed patients. 

• The Letter Merge feature includes a new option that allows you to open a data 
file in Microsoft Excel. 

• The Patient Report View dialog box associated with the Office Manager’s 
Letters feature was redesigned to list all the available data fields in a single tree 
view. A new Select All option was added so you can select all data fields at once. 
A new Email option in this dialog box allows you to specify whether you want to 
include patients With Email addresses, Without Email addresses, or All. 

• A new data field was added where you can specify the date a patient last 
referred another patient. 
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• The process of generating letters and lists is now simpler and requires fewer 
mouse clicks. It is more flexible when using data files and creating journal entries.

Office Manager

• In the Daily Huddle Report dialog box, you can use a new drop-down menu 
to specify whether you want to print/batch the Patient Visit Form or the Patient 
Route Slip.

• The Source of Payment list box in the Dental Insurance Plan Information and 
Medical Insurance Plan Information dialog boxes includes several new options 
that you can select. 

Miscellaneous

• Dentrix now includes a contact manager called eDex that lets you manage 
and quickly search for Dentrix contacts, such as patients, providers, staff, labs, 
insurance carriers, and other contacts. You can search by first or last name, 
address, email address, or phone number. You can also add custom notes or 
append notes to a patient note. A button to access eDex was added to the 
toolbars of most Dentrix modules; a button and graphic was also added to the 
Dentrix Launcher. 

• The toolbar buttons for all modules were given a newer look. 

• A new CMS 1500 Form was added to the Ledger. The instructions for completing 
the new claim form are available on the National Uniform Claim Commitee 
(NUCC) website.
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Tips for a Successful Installation
For a successful installation, read the following information before installing Dentrix. 
Call 1.800.DENTRIX or send an e-mail message to support@dentrix.com for any 
questions related to these installation tips. 

1 Meet the System Requirements: Make sure the server and workstations on 
your network meet the current system requirements before you upgrade 
to or install Dentrix G6. The current Dentrix G6 System Requirements are 
available online at www.Dentrix.com.

2 Back Up Your Data: Create a backup of the server’s hard drive. If you are 
upgrading, back up the server’s Dentrix directory and all subdirectories. If any 
Dentrix data is stored elsewhere on the system, back up that directory as well. 
Verify the integrity of all backups to be sure you have a good backup before 
upgrading from a previous version of Dentrix. For more information, refer to the 
Dentrix G6 Recommendations document in the Dentrix Resource Center at 
www.Dentrix.com/support/resource-center.

3 Check Available Disk Space: From the Start menu, click Computer. Right-click 
the C:\ drive icon and then click Properties. The Local Disk Properties dialog 
box appears, and the General tab displays the used and free disk space. Refer 
to the Dentrix G6 System Requirements for the required free hard disk space for 
servers and workstations. The Dentrix G6 System Requirements are included in 
the box with your Dentrix software and are available online at www.Dentrix.com.

Note: If you use imaging software and/or the Document Center, you must dedicate 
an additional 30-40 GB of hard drive space in addition to what is needed for the 
G6 Server installation.

4 Prepare for Server and Workstation Installation: Find the Serial Number/
Activation Code card inside the Dentrix G6 software box. These numbers will be 
needed during the installation (unless you are upgrading and have previously 
completed the activation). You can find these numbers in the box with your 
Dentrix software. If you are upgrading, check the Practice Assistant for reports. 
Print the reports and clear the Batch Processor. Send all unsent electronic claims. 
Depending on the size of your network, installing Dentrix G6 on your server and 
all of your workstations could be time-consuming. Please plan accordingly.
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Note: Since the Dentrix G6 installation/upgrade process could clear any reports in 
the Batch Processor or Practice Assistant and delete any unsent electronic claims, 
we recommend that you print any reports you need before installing or upgrading.

5 For Upgrades, Verify the Correct Version is Currently Installed: Dentrix G4 
with Productivity Pack 8 or G5.2 must be installed before you can upgrade the 
program to Dentrix G6. To determine which version of Dentrix is installed, in 
the Office Manager, from the Help menu, click About Office Manager. If the 
version is not Dentrix G4 with Productivity Pack 8 or G5.2, all product upgrades 
must be installed to bring the version to one of these supported versions. For 
example, if Dentrix 11.0 is currently installed, you must upgrade to version G4 with 
Productivity Pack 8 before installing Dentrix G6.

6 Close Other Programs and Exit Dentrix at Each Workstation: To avoid conflicts 
and allow access to all files and directories, you should disable any anti-virus and 
screensaver software and then re-enable it after you have completed the Dentrix 
installation. You should also close any other programs on the Dentrix server and 
all workstations. If you are upgrading, before installing Dentrix, close any Dentrix 
modules. During server installation, it is best to shut down each workstation (to 
prevent others from starting Dentrix while it is being updated).

7 Follow the Installation Instructions: Make sure you follow all of the step-by-step 
instructions in the Dentrix G6 Installation Guide as you install Dentrix G6.

8 Finish the Installation Completely: Do not interrupt the installation process, even 
if it appears as though nothing is happening. You will be prompted when the 
installation is ready to continue. Terminating an installation prior to completion 
could affect the integrity of the database. Terminate the installation only if you 
are directed to do so by Dentrix Customer Support.

9 Before installing Dentrix G6: Be sure to check with the applicable application 
vendors to access these G6-compatible versions. To see a list of authorized 
vendors with applications designed to integrate with Dentrix G6, visit: 
www.Dentrix.com/products/henry-schein-partners.
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Installing Dentrix G6
Read the Tips for a Successful Installation before beginning the installation. If 
Dentrix is being installed on a networked system, the installation process must be 
completed on each workstation. Install Dentrix on the file server (the computer 
where the practice database will be stored) first.

1. Insert the Dentrix G6 DVD into the DVD drive. If the DVD drive is equipped with 
AutoStart technology, the following screen will appear within a few seconds.

If the screen does not appear:

A. Click the Windows Start button and then click Run.

B. The Run dialog box appears.

C. In the Open field, type D:\DENTRIX_G6 (where D: is the drive 
letter for the DVD drive).

D. Click OK to begin the installation. 

Dentrix performs a check of your system to verify that all required components 
(such as the required versions of Microsoft .NET Framework) are installed on your 
computer. After Dentrix has performed the check, Dentrix prompts you to install 
any required components that are not already installed.
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Note: If the Microsoft .NET Framework 3.5.1 and 4.0 are not already installed on 
your computer, installing them will require several minutes. After they are installed, 
some computers may need to be rebooted.

Dentrix installs several prerequisites, such as the Edidev runtime and Crystal 
Reports prerequisites, which are needed for Dentrix G6. This will probably take 
several minutes.

The Dentrix installation then displays the Welcome screen.

2. After you have read the Tips for a successful installation, select I have read and 
followed the tips for a successful installation and click Next to continue.

Note: If you are upgrading from a previous version of Dentrix, you will be prompted 
again to back up your data before proceeding. If you have backed up your data, 
click Yes to continue with the installation.

The End User License Agreement screen appears.
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3. After you have read the Software End User License Agreement, select I accept 
the terms of the license agreement and click Next to continue.

The Select Installation Type screen appears.

4. Select the type of installation you are performing:
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Note: The Dentrix server must be upgraded or installed first before you can install 
Dentrix on any workstations.

• Server and Workstation Files – Select this type if this computer will be used 
as the Dentrix server and a workstation, or if you are installing a single-user 
version of Dentrix.

• Server Files Only – Select this type of installation if you are installing on the 
computer that will act as the Dentrix database server for all other computers 
on the network.

• Workstation Files Only – Select this type of installation if you are installing 
Dentrix G6 on a front office or clinical workstation over a network and have 
already run the server installation on another computer on the network.

5. Click Next.

If you selected either Server option, and the Dentrix installation detects other Dentrix 
database servers on your network, you will be prompted to either configure this 
computer as a workstation (recommended) or continue and configure this computer 
as an additional server.

A message appears asking if you want to use an existing Dentrix database or 
install a blank (empty) database (for new users).

6. Click the option that is applicable to your office Use an existing Dentrix 
database, or Create a blank (empty) database.

If you selected the Workstation Install Only option, you are shown a list of 
available Dentrix servers and are prompted to select the server that you want 
to connect to.
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7. Select the server that you want to connect to and click OK.

Dentrix runs a system requirements check. If your system meets the 
requirements, the installation continues to the next step. If it does not meet the 
requirements, the Dentrix System Requirements Notice dialog box displays 
what your system needs in order to meet the system requirements.
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8. If the System Requirements Notice dialog box appears, verify the system 
requirements. A green check mark indicates that a component meets the 
requirements. A red “X” indicates that a component does not meet the 
requirements. To discontinue the installation and install the required components 
(recommended), click No to stop the installation. Click Yes to continue the 
installation without the recommended system requirements.

The User Name and Serial Number screen appears.

9. Enter your User Name and Serial Number. Your serial number is on the Serial 
Number/Activation Code card inside the Dentrix G6 software box.

If you are upgrading, the serial number you previously used to install Dentrix 
will automatically appear in the Serial Number field. Verify that the serial number 
in the field is the serial number that was assigned to your office when you 
originally purchased Dentrix. In some instances, the serial number shown may 
not be the one assigned to your office.

To verify that your serial number is correct, consult the card that was included in 
the box with your Dentrix software. Enter the serial number that was assigned 
to your office to continue with the installation.

Important: You must enter the serial number that was assigned to your office in the 
Serial Number field in order for the registration/activation and Check for Updates 
features to work properly.
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10. Click Next.

The Select Installation Type screen appears.

11. You can perform one of two installation types: Typical or Advanced. With a 

typical installation type (recommended for most computers), folders are placed in 

the default locations, and all of the default Dentrix G6 features are installed. With 

the advanced installation, you can specify the location of the Dentrix files.

If you select Typical, the Start Installation Screen appears. Proceed to Step 11. 

If you select Advanced, the Dentrix Server Drive Select dialog box appears. 

Follow these substeps before proceeding to Step 12.
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A. Select the drive where you want to install the Dentrix server files and click Select.

The Choose Destination Location screen appears.

B. To change the folder locations, click Browse, navigate to the desired 
location, and then click Next. To use the default folder locations, click Next.

The Start Installation screen appears.
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12. Review the settings that have been specified for your installation. To make 
changes to any of the settings, click Back and change them. When the settings 
are correct, click Install to begin installing Dentrix G6.

If you are upgrading to Dentrix G6 and converting your Dentrix database, 
a message appears, stating that the Dentrix G6 conversion can require 
considerable time depending on the size of your database. To proceed with the 
database conversion and Dentrix installation, click Yes.

As Dentrix is being installed on your computer, the Setup Status screen displays 
the current setup status.

Note: If you see the Microsoft Office Customization Installer message at some 
point, click Install to continue the installation of this component.
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If you have installed eSync on the computer, the Dentrix installation will prompt 
you to dowload the latest version of eSync and the eSync plug-ins, which 
includes Dentalink, an intra-office messaging tool.

If you use eSync, and eSync is not installed on the computer, you will need to 
download and install the latest version of eSync.

After Dentrix is installed, the Setup Complete screen appears.

 

13. Click Finish.

A Backup Warning message may appear, letting you know that Dentrix G6 uses a 
new location for its database.
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14. Click OK.

The Dentrix Server Administration Utility appears. Use this utility to schedule 
recurring exports of your Dentrix database to be backed up using your backup 
software (sold separately).

If you need assistance using the Dentrix Server Administration Utility to schedule 
database exports, please contact Dentrix Customer Support at 1.800.DENTRIX.

15. When finished, click Exit.

Note to integrators: For network installations, the C:\DENTRIX\Common folder on 
the server should be shared. (The Dentrix installation will attempt to automate this.)

The Dentrix installation will add these exceptions to the Windows firewall (any 
third-party firewalls should be configured so that these ports are open): TCP 6597, 
TCP 5712 TCP 6602, TCP 6603, TCP 6604, TCP 6605, TCP 6606, TCP 6610, and 
UDP 6600. 
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Registering/Activating Dentrix G6
You must register and activate Dentrix G6 in order to run your software and receive 
update information. We recommend that you register and activate Dentrix at the time 
of installation. If you do not register at the time of installation, the activation dialog 
box appears when you open any Dentrix module. You have 30 days in which to 
register before registration/activation is required to use your software.

You can register/activate your software by clicking Register Now. You can 
temporarily skip the registration/activation process by clicking Register Later.

Register Now

You only need to register your software once, regardless of how many workstations 
you have.

To register your software

1. From any workstation, click Register Now on the registration/activation dialog box.

The serial number and activation code verification dialog box appears.
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2. The serial number you entered when you installed Dentrix G6 appears in the 
Serial Number field. Verify that the serial number matches the serial number 
assigned to your office. You can find your serial number on the Serial Number 
& Activation Code card inside the Dentrix software box you received when you 
purchased Dentrix.

3. In the Activation Code field, enter the activation code assigned to your practice. 
You can find your activation code on the Serial Number & Activation Code card 
inside the Dentrix software box you received when you purchased Dentrix.

Important: You must enter the correct serial number and activation code assigned 
to your practice. If you do not enter the correct serial number and activation code, 
you will not be able to activate the software properly or download the correct 
updates for your software.

4. Once you have entered the correct serial number and activation code, click Next.
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5. Select the desired option: Register Online, or Manually enter registration code.

Note: Registering online requires a valid Internet connection. If you do not have 
an Internet connection, you must manually enter the registration code.

These options are explained below.

Registering Online

To register your Dentrix software online

1. Click Register.

The registration tool checks your serial number and automatically registers 
and activates your software. A message appears when the activation has been 
completed successfully.

2. Click OK. 

Manually Entering Registration Code

To register your Dentrix software manually

1. Call Dentrix Customer Support at 1.800.DENTRIX to obtain your complete 
registration code. When you call, you must have your full serial number available, 
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which is located on the Serial Number & Activation Code card inside the Dentrix 
G6 software box. 

2. Dentrix Customer Support will provide you with a 16-digit registration code. Enter 
your registration code (obtained by calling Dentrix Customer Support) in the 
fields provided (four digits in each field).

Important: The activation code found on your Serial Number and Activation Code 
Card is for online registrations only, and is not the registration code you should 
enter here.

3. Click Register.

A message appears when the activation has been completed successfully.

4. Click OK.

Register Later

If you click Register Later on the registration/activation dialog box, the reminder will continue 
to appear once a day when you open Dentrix until the end of your 30-day grace period. 
After 30 days, the Register Later button is disabled on the registration/activation dialog 
box, and you must register Dentrix G6 before you can use it. Follow the steps in the 
Register Now section above to register/activate your software so you can use it.

Update Manager

Note: You can use the Smart Upgrades feature to deploy Dentrix G6 to a computer 
on your network without accessing the setup files on the server or taking the DVD 
to the other computers. Once you have upgraded one computer to G6, you can 
use the Update Manager to update the remainder of your computers. This is the 
preferred method of upgrading.

As with all versions of Dentrix, once you have installed updates on any computer on 
your network, Dentrix requires you to install the updates on all other computers on 
your network.

With Dentrix G6, this process is automated if you have already upgraded to Dentrix G6 
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on your server. When you attempt to open a Dentrix module on a computer that has 
not yet installed the required updates, a message box appears, notifying you that 
the computer needs to install updates.

You must install the required updates to use Dentrix on that computer. If there are 
optional updates to install, you can choose to install those updates, but it is not 
required to run Dentrix.

To install the updates, click Install. All open Dentrix programs close, and an install 
status message box appears. The updates install, and you can then access Dentrix 
on that computer.

Note: If you stop the installation before it is finished, you will be prompted to install 
the updates again when you try to access Dentrix.

Installing Dentrix G6 Over a Network
After you have upgraded to Dentrix G6 on your server, you can follow these instructions 
and install Dentrix G6 from the setup files on the server. This installation method does 
not require the DVD.

To install Dentrix G6 over a network

1. Click the Windows Start button and click Run.

2. Enter \\[server]\Common\Installs\g6\Setup.exe on the command line, where 
“Server” represents the name of your Dentrix server computer on the network. 
The Installation Setup screen appears for several seconds, followed by the 
Welcome screen.

3. Click Install Software. The screen that appears lists the products you can install. 
From this screen, you can install Dentrix G6 and the Required Components.

4. Click Install Dentrix G6. The InstallShield Wizard begins installing Dentrix.

Note: If your system does not meet the system requirements, the Dentrix System  
Requirements Notice dialog box displays what your system needs in order to 
meet the system requirements.

After the Dentrix software has been installed, the Setup Complete screen appears.

5. Select whether you want to restart your computer now or later and click Finish.
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